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COMPLIANCE INFORMATION STATEMENT
(DECLARATION OF CONFORMITY PROCEDURE)
Responsible Party :
Address :
Telephone :
Type of Equipment :
Model Name :

Yamaha Corporation of America
6600 Orangethorpe Ave., Buena Park, Calif. 90620
714-522-9011
COMPUTER RECORDING SYSTEM
AUDIOGRAM 3

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received including interference that may cause undesired operation.
See user manual instructions if interference to radio reception is suspected.
* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA.

(FCC DoC)

FCC INFORMATION (U.S.A.)
1. IMPORTANT NOTICE: DO NOT MODIFY THIS UNIT!
This product, when installed as indicated in
the instructions contained in this manual,
meets FCC requirements. Modifications not
expressly approved by Yamaha may void your
authority, granted by the FCC, to use the
product.
2. IMPORTANT: When connecting this product to accessories and/or another product use
only high quality shielded cables. Cable/s
supplied with this product MUST be used. Follow all installation instructions. Failure to follow instructions could void your FCC
authorization to use this product in the USA.
3. NOTE: This product has been tested and
found to comply with the requirements listed
in FCC Regulations, Part 15 for Class “B” digital devices. Compliance with these requirements provides a reasonable level of
assurance that your use of this product in a
residential environment will not result in harmful interference with other electronic devices.
This equipment generates/uses radio frequencies and, if not installed and used
according to the instructions found in the
users manual, may cause interference harmful to the operation of other electronic devices.

Compliance with FCC regulations does not
guarantee that interference will not occur in all
installations. If this product is found to be the
source of interference, which can be determined by turning the unit “OFF” and “ON”,
please try to eliminate the problem by using
one of the following measures:
Relocate either this product or the device that
is being affected by the interference.
Utilize power outlets that are on different
branch (circuit breaker or fuse) circuits or
install AC line filter/s.
In the case of radio or TV interference, relocate/reorient the antenna. If the antenna leadin is 300 ohm ribbon lead, change the lead-in
to co-axial type cable.
If these corrective measures do not produce
satisfactory results, please contact the local
retailer authorized to distribute this type of
product. If you can not locate the appropriate
retailer, please contact Yamaha Corporation of
America, Electronic Service Division, 6600
Orangethorpe Ave, Buena Park, CA90620
The above statements apply ONLY to those
products distributed by Yamaha Corporation
of America or its subsidiaries.

* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA.

(class b korea)
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(class B)

PRECAUTIONS
PLEASE READ CAREFULLY BEFORE PROCEEDING
* Please keep this manual in a safe place for future reference.

WARNING
Always follow the basic precautions listed below to avoid the possibility of serious injury or even death from
electrical shock, short-circuiting, damages, fire or other hazards. These precautions include, but are not
limited to, the following:

Do not open

Water warning

• Do not open the device or attempt to disassemble the internal
parts or modify them in any way. The device contains no
user-serviceable parts. If it should appear to be
malfunctioning, discontinue use immediately and have it
inspected by qualified Yamaha service personnel.

• Do not expose the device to rain, use it near water or in damp
or wet conditions, or place containers on it containing
liquids which might spill into any openings. If any liquid
such as water seeps into the device, unplug the USB cable
from this device immediately. Then have the device inspected
by qualified Yamaha service personnel.
• Never insert or remove a USB cable with wet hands.

CAUTION
Always follow the basic precautions listed below to avoid the possibility of physical injury to you or others,
or damage to the device or other property. These precautions include, but are not limited to, the following:

Location

Handling caution

• Before moving the device, remove all connected cables.
• Avoid setting all volume controls to their maximum.
Depending on the condition of the connected devices, doing
so may cause feedback and may damage the speakers.
• Do not expose the device to excessive dust or vibrations, or
extreme cold or heat (such as in direct sunlight, near a
heater, or in a car during the day) to prevent the possibility of
panel disfiguration or damage to the internal components.
• Do not place the device in an unstable position where it
might accidentally fall over.
• Do not use the device in the vicinity of a TV, radio, stereo
equipment, mobile phone, or other electric devices. Doing so
may result in noise, both in the device itself and in the TV or
radio next to it.

Connections
• Before connecting the device to other devices, turn off the
power for all devices. Before turning the power on or off for
all devices, set all volume levels to minimum.

• When turning on the AC power in your audio system, always
turn on monitor speakers LAST, to avoid speaker damage.
When turning the power off, monitor speakers should be
turned off FIRST for the same reason.
• Do not insert your fingers or hands in any gaps or openings
on the device.
• Avoid inserting or dropping foreign objects (paper, plastic,
metal, etc.) into any gaps or openings on the device. If this
happens, unplug the USB cable from the device immediately.
Then have the device inspected by qualified Yamaha service
personnel.
• Do not use the device or headphones for a long period of
time at a high or uncomfortable volume level, since this can
cause permanent hearing loss. If you experience any hearing
loss or ringing in the ears, consult a physician.
• Do not rest your weight on the device or place heavy objects
on it, and avoid use excessive force on the buttons, switches
or connectors.
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MIC/INST jacks (XLR-type) are wired as follows (IEC60268 standard): pin 1: ground, pin 2: hot (+), and pin 3: cold (-).

2
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Yamaha cannot be held responsible for damage caused by improper use or modifications to the device, or data that is lost
or destroyed.
Always unplug the USB cable from a computer or turn off the computer to turn off the device when the device is not in use.
The performance of components with moving contacts, such as switches, volume controls, and connectors, deteriorates over
time. Consult qualified Yamaha service personnel about replacing defective components.

SPECIAL NOTICES
• This manual is the exclusive copyright of Yamaha Corporation.
• The included software is the exclusive copyright of Steinberg Media Technologies GmbH.
• Copying of the software or reproduction of this manual in whole or in part by any means is expressly forbidden without the
written consent of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be
held responsible for the results of the use of this manual and the software.
• This disk containing the software is not meant for use with an audio/visual system (CD player, DVD player, etc.). Do not
attempt to use the disk on equipment other than a computer.
• Future upgrades of application and system software and any changes in specifications and functions will be announced
separately.
• The screen displays as illustrated in this manual are for instructional purposes, and may appear somewhat different from the
screens which appear on your computer.
The illustrations and LCD screens as shown in this manual are for instructional purposes only, and may appear somewhat
different from those on your instrument.
This product incorporates and bundles computer programs and contents in which Yamaha owns copyrights or with respect to
which it has license to use others' copyrights. Such copyrighted materials include, without limitation, all computer software,
music data, etc. Any unauthorized use of such programs and contents outside of personal use is not permitted under relevant
laws. Any violation of copyright has legal consequences. DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.
• Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.
• Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.
• The company names and product names in this manual are the trademarks or registered trademarks of their respective
companies.
* Specifications and descriptions in this owner’s manual are for information purposes only. Yamaha Corp. reserves the right
to change or modify products or specifications at any time without prior notice. Since specifications, equipment or options
may not be the same in every locale, please check with your Yamaha dealer.
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Introduction
Thank you for choosing a Yamaha AUDIOGRAM 3 Computer Recording System. The AUDIOGRAM 3 includes a USB audio interface for digital audio data transfer, and Cubase AI DAW
(Digital Audio Workstation) software for Windows® and Macintosh® computer operating systems. With the AUDIOGRAM 3 and your personal computer you have the basic elements of a
high-performance computer recording system that is easy to set up and operate.
Please read through this manual carefully before beginning use, so that you will be able to take
full advantage of your interface’s superlative features and enjoy trouble-free operation for years
to come. After reading the manual, please store it in a safe place.
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Introduction

Features
Connect To Your Computer via a Single USB Cable (page 8)
The AUDIOGRAM interface connects to your computer via the supplied USB cable. Stereo audio
data is transferred in both directions—from the interface to the computer, and vice-versa—via the
USB connection (44.1 kHz or 48 kHz sampling frequency).

No Driver Installation Required (page 8)
The AUDIOGRAM system uses the standard drivers included in your computer’s operating system,
so there’s no need to install any extra driver software.

Cubase AI DAW Software Supplied (page 8)
Cubase AI software, included in the AUDIOGRAM package, offers versatile, high-performance harddisk recording capability.

48V Phantom Power (page 18)
A PHANTOM switch supplies +48V phantom power to the channel 1 microphone input, so you can
use high-quality phantom-powered condenser microphones for superior recording quality.

Accessories
• Cubase AI DVD-ROM
• USB cable
• Owner’s Manual (this book)
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Setup
Be sure to turn the PHANTOM
+48V switch (★) on when
using a phantom-powered
condenser microphone.
Microphone

Keyboard, etc.

Audio system

Headphones

USB cable

To connect a device such as a
microphone:

Cubase AI

Computer

To connect an instrument such
as an electric guitar or bass:
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Quick Guide
This quick setup and operation guide covers everything from installing the Cubase AI
software to using Cubase AI for recording and mixdown. While going through this section
you might find it useful to also refer to the “Controls and Functions” section on page 18, as
well as the pdf manual supplied with the Cubase AI software.
Step

1

Important!

1
2
3

Installing Cubase AI
You are only permitted to use this software pursuant to the terms and conditions of the
“Steinberg Software End User License Agreement (EULA)” shown during the installation.

Start the computer and log on to the Administrator account.
Insert the included DVD-ROM into the computer’s DVD-ROM drive.
Follow the on-screen instructions to install the Cubase AI software.
NOTE

Step

2

• In order to have continuous use of Cubase AI, including support and other benefits, you
will need to register the software and activate your software license by starting it while the
computer is connected to the Internet. Click the “Register Now” button shown when the
software is started, then fill in all required fields for registration. If you do not register the
product, you will be unable to use the application after a limited period of time expires.
• To install on Mac computers double-click the “Cubase AI*.mpkg” icon or the “Cubase AI*
Start Center” icon.
“*” indicates where the version number appears in the actual icon name.
• Visit the web address below for the latest information on:
<http://www.yamahasynth.com/>

Connecting to the AUDIOGRAM interface

Be sure to turn the PHANTOM +48V switch on when
using a phantom-powered
condenser microphone.

LEVEL controls

8

OUT LEVEL control

1

Turn all gear that is to be connected to the AUDIOGRAM off or to standby mode (except the
computer), and set the LEVEL controls and OUT LEVEL control to their minimum settings.

2

Connect microphones and/or instruments.
For details on making connections refer to the “Setup” section on page 7 and the “Controls and Functions” section on page 18.

3

Set the MIC/INST switch according to the type of device connected to channel 1.
Select MIC (
) if a microphone is connected, or INST (
) if a guitar or similar instrument is connected.
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Step

3

Powering Up the System

To prevent loud pops and noises, turn on the power to your sound gear starting with the sources
(instruments, CD players, etc.) and ending with the audio system (monitor speakers).

1
2

Turn on the instruments and microphones.
If you are using a condenser microphone for the channel 1, turn on the PHANTOM +48V
switch.
Observe the following precautions when turning on phantom power.
CAUTION

• Make sure that the PHANTOM +48V switch is off when phantom power is not
needed.
• When turning the switch on, be sure that only a condenser microphone is connected to the MIC/INST input jack. Other devices may be damaged if connected to
phantom power. This precaution does not apply to balanced dynamic microphones
or instruments with the phone jack, however, as these will not be affected by phantom power.
• To prevent damage to speakers, be sure to turn off audio system (monitor speakers)
before turning this switch on or off. We also recommend that you set the OUT
LEVEL control to the minimum position before operating this switch to avoid the
risk of loud noises that could cause hearing loss or device damage.

3

Connect the AUDIOGRAM interface to your computer using the supplied USB cable.
The POWER indicator will light to indicate that power is being applied to the AUDIOGRAM interface.

USB Connection Precautions
Be sure to observe the following points when connecting to the computer's USB interface.
Failure to observe these rules can result in computer freezes/hang-ups and possibly data loss
or corruption. If the instrument or computer does hang up, restart the application or computer.
• Be sure to wake the computer from sleep/suspended/standby mode before
making a connection to the computer’s USB connector.
CAUTION

• Always quit all applications running on the computer before connecting or disconnecting the USB cable.
• Wait at least 6 seconds between connecting or disconnecting the USB cable.
When connecting or disconnecting the USB cable be sure to turn the OUT LEVEL control all the way down.
CAUTION

NOTE

4

The first time you connect to the computer’s USB connector, or change the connection
to a different USB port, a driver installation display may appear. If this occurs, wait until
the installation is complete before proceeding.

Turn the power to the audio system (monitor speakers).
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Step

1

4

Adjusting Level

Adjust the volume on all instruments that are connected to the AUDIOGRAM interface.
Set the OUT LEVEL control to the minimum position. Failure to do so may result in
loud noise bursts that can damage your equipment, your ears, or both.
CAUTION

2

Adjust the channel LEVEL controls so that the level indicator PEAK LED flash briefly on
the highest peak levels.

3

Adjust the overall volume with the OUT LEVEL control while monitoring via headphones
or monitor speakers.

OUT LEVEL control
LEVEL controls

Step

5

Level indicator

Recording with Cubase AI

This section describes the procedure for recording to the Cubase AI software we installed earlier via
the AUDIOGRAM interface.
NOTE

Cubase AI 6 is used for the examples in this manual. For details about other versions of Cubase
AI or Cubase AI operation in general, refer to the PDF manual provided with the software.

Cubase AI Setup

1

Set the computer output to the maximum level.
For details on how to make the setting refer to the “The recorded sound is too low in level.” section in the
“Troubleshooting” on page 20.

2

Launch Cubase AI.
Windows:
Click [Start] → [All Program] → [Steinberg Cubase AI *] → [Cubase AI *] to launch the program. (“*”
indicates where the version number appears in the actual icon name.)
NOTE If the ASIO Direct Sound Full Duplex Driver dialog window appears, click [OK].
Mac:
Double-click the [Application] → [Cubase AI *]. (“*” indicates where the version number appears in the
actual icon name.)
NOTE

10

• If you specified a file destination when installing the Cubase AI software, launch the application from that location.
• Create a Cubase AI shortcut or alias on your desktop so you can easily launch the program when required.
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When the Project Assistant window appears, select the [More] menu → [Empty] and
click [Create].

A new project is created.
NOTE

4

Recorded Cubase AI data is stored as a “Project.”.

Select [Device Setup] from the [Devices] menu to open the Device Setup window.
Windows:
Select [VST Audio System] in the [Devices] field on the left side of the window. Select [ASIO DirectX
Full Duplex Driver] in the [ASIO Driver] field on the right side of the window. A dialog box will appear
asking “Do you want to switch the ASIO driver?”. Click [Switch].

Mac:
Select [VST Audio System] in the [Devices] field on the left side of the window. Select [USB Audio
CODEC] in the [ASIO Driver] field on the right side of the window. A dialog box will appear asking
“Do you want to switch the ASIO driver?”. Click [Switch].
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5

Select [ASIO DirectX Full Duplex Driver](Windows), [USB Audio CODEC](Mac) in the
[Devices] field on the left side of the Device Setup window, and click [Control Panel] on
the right side of the window.

Windows:
The ASIO Direct Sound Full Duplex Setup dialog box will be displayed. Check only the input port and
output port [USB Audio CODEC] checkbox, and then click [OK] to close the dialog window.

Mac:
The [CoreAudio Device Settings] dialog window appears. Check only the [USB Audio CODEC]
checkbox in both “Input” and “Output” of the [Input/Output Configuration] field. Click [Close] to close
the dialog window.

6

Make sure that “USB Audio CODEC 1/2”(Windows), “Front Left/Front Right” (Mac) are
shown in the [Port System Name] field, and check the [Visible] column in the Device
Setup window. Click [OK] to close the window.
NOTE

12

If the [Port System Name] field does not change, close and restart the Cubase AI, then open
the Device Setup window.
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Select [VST Connections] from the [Devices] menu.
Windows:
If “Not Connected” is selected in the [Audio Device] field, click on the “Not Connected” indication, and
then switch to [ASIO DirectX Full Duplex Driver].
Also set the [Outputs] in the same way, and then close the window.

Mac:
If “Not Connected” is selected in the [Audio Device] field, click on the “Not Connected” indication, and
then switch to [USB Audio CODEC].
Also set the [Outputs] in the same way, and then close the window.

8

Select [Add Track] → [Audio] from the [Project] menu.
The Add Audio Track dialog window appears.

9

Set the “Count” and “Configuration” parameters, and then click [Add Track].

The added tracks will appear.
NOTE

You will normally use a stereo track when recording synthesizers, and a monaural track
when recording vocals or guitars.

Preparing to Record

1

Click in the track list (the area in which the track names are displayed) to select a track
to record on.
The various settings for the selected track are available in the Inspector on the left side of the display.

[Record Enable] button

Track list

Inspector
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2

Make sure the [Record Enable] button for the track to be recorded is turned on.
If the [Record Enable] button is off, click it to turn it on.

3

Play the instrument to be recorded, and adjust the AUDIOGRAM LEVEL controls so that
the Clipping indicator never lights.
<Transport panel>
Clipping indicator

4

Specify the point at which you want to start recording via the ruler at the top of the window for the project.
Click the black area of the ruler to move the project cursor (the vertical black line) to that position.
Ruler

Recording and Playback

1

Click the Transport panel [Record] button to begin recording.
When recording is started the project cursor will begin moving to the right and a box that displays the
recording results will be created.

<Transport panel>

Start
Rewind

2
3

14

Forward

Stop

Recording results
Record

Play the part.
When you finish recording the track, click the Transport panel [Stop] button.
To hear playback of the track you have just recorded, use either the Transport panel [Rewind] button or
the ruler to rewind to the beginning of the recorded section, then click the Transport panel [Start] button.
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Select [Mixer] from the [Devices] menu to open the Mixer window.
The overall playback level will be displayed via the master section bus level meter on the right side of
the mixer window, and the channel level will be displayed via the channel strip level meter.
NOTE

To hear the playback sound via the AUDIOGRAM interface, adjust the volume with the OUT
LEVEL control.
The playback level will approximately match the recording level when the computer output is
set to the maximum level.

Level meter

Bus level meter

5

To save the project select [Save] from the [File] menu and enter a file name before actually saving the file.
Save your project frequently to insure against losing large amounts of data if a problem occurs.

6
7

Repeat steps 1 through 5 to record further material on the same track.
To record additional material on a different track, select a new track and repeat the
record procedure.

Recording with maximum quality and minimum noise:
For optimum sound quality with minimum noise, the AUDIOGRAM signal levels should be set as high
as possible without clipping. Check signal levels to be sent to Cubase AI for recording using the
AUDIOGRAM level indicators while the Cubase monitoring button ( ) is turned off. Adjust the channel LEVEL controls so that the level indicator PEAK LEDs flash only occasionally on the highest input
transients.

Monitoring button
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Step

6

Mixing with Cubase AI

In this section we’ll try mixing down multiple recorded audio tracks to stereo, and creating an
audio file. Mixes can be stored as WAV or AIFF files, which can then be recorded to audio
CDs.

1
2
3

Launch Cubase AI and open a project file.

4

Drag the pan controls on the top of the channel strips left and right to set the stereo
position of each track.

5

At this point you can begin to use EQ to refine your mix, and add effects.
As an example let’s try adding reverb. Click the [Edit] button ( ) on the left side of the channel strip to
open the VST audio channel settings window. Click Inserts 1 and select “Reverb - RoomWorks SE.”

Click the [Start] button on the Transport Panel.
While listening to playback, drag the channel strip level faders up and down to create
the desired initial balance, then adjust the overall volume using the bus volume fader.

NOTE

For further details refer to the pdf manual provided with the Cubase AI software.
It’s a good idea to lower the channel fader a bit before adding an effect, since the effect
can cause an increase in the overall channel level.

CAUTION
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6

Double-click the left locator (starting point) and right locator (ending point) of the Transport panel. Change each highlighted number, and then specify the position of the locator.
Bar

7

When the final mix adjustments have been made, go to the [File] menu and select
[Export] → [Audio Mixdown].

8

Enter a file name and select a destination for the file as well as a file type.
If you intend to use the file to create an audio CD, select the WAV file type (AIFF on Mac OS X), 44.1
kHz, and 16 bit.

9

Click [Export].
Progress of the mixdown operation will be shown in a progress window. When the progress window
closes the mixdown is complete.
NOTE

Files created by mixdown can be directly played back using the Windows Media Player, or
iTunes.
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Controls and Functions
Control Panel

u

q

ew

1 PHANTOM +48V Switch/Indicator
This switch toggles phantom power on and
off. If you set the switch on (
), the
AUDIOGRAM supplies phantom power to
the MIC/INST jack (XLR-type) 8. Turn this
switch on when using a phantom-powered
condenser microphone.

CAUTION

• Be sure to leave this switch off
(
) if you do not need phantom
power.
• When turning the switch on, be
sure that only a condenser microphone is connected to the MIC/
INST input jack. Other devices
may be damaged if connected to
phantom power. This precaution
does not apply to balanced
dynamic microphones or instruments with the phone jack, however, as these will not be affected
by phantom power.
• To prevent damage to speakers,
be sure to turn off audio system
(monitor speakers) before turning this switch on or off. We also
recommend that you set the OUT
LEVEL control to the minimum
position. Neglect of these precautions may result in large
noise bursts that may damage
your equipment, your ears, or
both.

2 MIC/INST Switch
Set this switch according to the type of
device connected. Select MIC (
) if a
microphone is connected, or INST (
) if
an electric guitar or bass is connected.
If a device is not connected to the
NOTE
MIC/INST jack, set this switch to
MIC (
). Otherwise noise may
occur.

18
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3 LEVEL Controls
Adjusts the level of the channel signal. Use
these controls to adjust the balance
between the channels.

4 POWER Indicator
This indicator lights when power is applied
to the AUDIOGRAM interface via the USB
cable (supplied) that connects it to the
computer.

5 Level Indicators
These indicators show signal levels prior to
the OUT LEVEL control 6. The SIGNAL
LED lights when a signal is present, and
the PEAK LED lights when the signal
reaches or exceeds clipping level. Adjust
the input channel LEVEL controls 3 so
that the PEAK LEDs flash only briefly on
occasional high-level peaks or not at all.

6 OUT LEVEL Control
Adjusts the signal level sent to the STEREO OUT jacks 0. This allows you to
adjust the overall volume without changing
the relative volume balance among the
channels.

CAUTION

When connecting or disconnecting
the USB or audio cables be sure to
turn the OUT LEVEL control all the
way down.

7 USB Connector
Connects the AUDIOGRAM interface to a
USB port on your computer via the supplied USB cable. In addition to transferring
audio data between the AUDIOGRAM
interface and the computer, the USB cable
supplies power from the computer to the
AUDIOGRAM interface.
Yamaha recommends that you
NOTE
use a USB cable with a length of
1.5 meter or less.

Controls and Functions

Rear Panel

!1

!0

o

8 MIC/INST Input Jack

If devices are connected to both phone
and pin jacks, only the signal from the
device connected to the phone jacks is
input.

Microphones and instruments such as guitars can be connected here using XLR or
phone jack cables. Set the MIC/INST
switch 2 to MIC or INST according to the
type of device connected.
XLR-type

i

Pin-type

Phone-type

Phone-type

0 STEREO OUT Jacks
NOTE

These output the mixed signal from channels 1 and 2. The output level can be
adjusted using the OUT LEVEL control.
These jacks would typically be connected
to an audio system (monitor speakers).

You can directly connect an electric guitar or bass without the
need for a separate DI (Direct
Injection) box or amp simulator.

NOTE

9 LINE Input Jacks
These inputs are intended mainly for use
with instruments and equipment having
stereo outputs, such as a synthesizer or
CD player.

You can use either the phone jacks
or pin jacks but not both at the
same time. If both jacks are used,
the signal is only output from the
phone jacks.

A PHONES Jack
Connects a pair of headphones to this
jack. The PHONES jack outputs the same
signal as the STEREO OUT jacks.

■ Input Signal Flow
5 Level
indicator

Adjust the recording level
as well as the balance
between channels.

Input

3 LEVEL Record
controls

Playback

Adjusts the
monitor level.

6 OUT LEVEL
control

Output

Cubase AI
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Troubleshooting
The AUDIOGRAM interface won’t turn on.
❑ Is the included USB cable properly plugged into the interface and a computer?
The system doesn’t work properly.

❑ Are the USB cable and all necessary audio cables properly connected?
❑ Are you using a USB hub?
USB hubs can interfere with proper operation, so try connecting the AUDIOGRAM interface
directly to a USB port on the computer. If the computer has multiple USB ports, try a different
USB port.
❑ Are you using other USB devices at the same time?
If so, try removing the other device(s) and connecting only the Yamaha USB device.
The Input ports are not shown (Windows 7/Vista)

❑ Is the sound input of your computer operating system assigned properly?
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the
“Sound” dialog window.
2. Click the “Recording” tab, right-click the “USB Audio CODEC” icon and select “Properties.”
3. Click the “Advanced” tab, then select “2 channel, 16 bit, 44100 Hz (CD Quality)” or “2 channel,
16 bit, 48000 Hz (DVD Quality)” in the “Default Format” field.
No sound.

❑ Are your speaker cables connected properly, or are they shorted?
❑ Are the volume controls of your sources, audio devices, applications software, computer operating system, etc., set at appropriate levels?

❑ Is the output of your computer operating system muted?
❑ Do you have several applications running at the same time?
Be sure to quit all applications you are not using.

❑ Is the sound output of your computer operating system assigned properly?
Windows 7/Vista:
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the
“Sound” dialog window.
2. Click the “Playback” tab and check whether the “USB Audio CODEC” icon is checked.
If not, right-click the “USB Audio CODEC” icon and select “Set as Default Device.”
3. Click the [Recording] tab and check whether the “USB Audio CODEC” icon is checked.
If not, right-click the “USB Audio CODEC” icon and select “Set as Default Device.”
Windows XP:
1. From the [START] menu click [Control Panel], then double-click the “Sounds and Audio
Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Audio” tab.
3. Set “Sound playback: Default device” and “Sound recording: Default device” to “USB Audio
CODEC.”
4. Click [OK].
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Mac:
1. Select “System Preferences ...” from the Apple menu and then select “Sound” to open the
“Sound” dialog window.
2. Click the “Input” tab and under “Choose a device for sound input” select “USB Audio CODEC”.
3. Click the “Output” tab and under “Choose a device for sound output” select “USB Audio
CODEC”.
❑ Is the sound output of the Cubase AI application assigned properly?
For setup details refer to page 8 of the Quick Guide.
The recorded sound is too low in level.
❑ Is the computer’s output level setting too low?
We recommend that you set the computer output to the maximum level and mute the computer’s
internal speaker.
Windows 7/Vista:
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the
“Sound” dialog window.
2. Click the “Playback” tab, right-click the “USB Audio CODEC” icon and select “Properties”.
3. Click the “Levels” tab, then set the volume slider to its maximum level.
Close the “Properties” dialog window.
4. Click the “Sounds” tab in the “Sound” dialog window, then select “No sounds” in the “Sound
Scheme.”
Windows XP:
1. From the [START] menu click [Control Panel], then double-click the “Sounds and Audio
Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Volume” tab.
3. Set “Device volume” to “High.”
4. Click the “Sound” tab.
5. Select “No sound” in the “Sound scheme.”
Mac:
1. Select [System Preferences ...] from the Apple menu and then select “Sound” to open the
“Sound” dialog window.
2. Click the “Output” tab and set the volume slider at the bottom of the window to its maximum
level.
3. Click the “Sound Effect” tab and set the volume slider of the “Alert volume” slider to its minimum level.
❑ Have you connected or disconnected the USB cable while Cubase AI is running?
Doing so can sometimes cause the Windows output level to be reset to its default level. Check
and raise the output level if necessary.
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The sound is intermittent or distorted.
❑ Is the PEAK LED flashing red?
You might have to lower LEVEL control levels to avoid distortion.
❑ Are any other applications, device drivers, or USB devices (scanners, printers, etc.) running at
the same time?
Be sure to quit all applications you are not using.
❑ Are you playing back a large number of audio tracks?
The number of tracks you can play at the same time will depend on the performance of the computer you are using. You may experience intermittent playback if you exceed your computer’s
capabilities.
❑ Are you recording or playing long continuous sections of audio?
The audio data processing capabilities of your computer will depend on a number of factors
including CPU speed and access to external devices.
On Windows XP computers, changing some settings as outlined below can improve performance.
1. Click [Control Panel] from the [START] menu, and double-click the “Sounds and Audio
Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Volume” tab and click “Advanced” in “Speaker settings.” The “Advanced Audio
Properties” dialog window will open.
3. Click the “Performance” tab. Set “Hardware acceleration” to “Full”, and “Sample rate conversion quality” to “Good.”
Don’t change these settings if you are not familiar with your computer’s operating system.
Check that the file system is set properly, and make sure that you have a plenty of free memory
(more than 128 megabytes). If the audio files you are recording or playing are not too large,
changing the virtual memory settings can sometimes improve audio performance.
In some cases it might be necessary to update your hard disk controller, device drivers, or BIOS.
Refer to your computer’s support center or support page on the web for more information.
❑ Try adding memory.
Adding more RAM memory can significantly increase your computer’s audio performance. Refer
to your computer’s owner’s manual for information on installing and setting up extra memory.
There is a delay when playing a software synthesizer via a MIDI keyboard (latency).

❑ Check the URL listed below for the latest information.
<http://www.yamahasynth.com/>
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Specifications
■ General Specifications
Jacks

MIC/INST Input Jack
LINE Input Jacks (L, R)
PHONES Jack
STEREO OUT Jacks (L, R)

Controls

Indicators

USB Connector
MIC/INST Switch
LEVEL Control
PHANTOM +48V Switch
OUT LEVEL Control
Phantom Power
Level Indicators
Power

Power Supply
Dimensions (W x H x D)
Net Weight
Included Accessories

x1
x1
x1
x1
x1
x1
x1
x1

Combo jack (Mic/HiZ)
Phone jacks
RCA pin jacks
Phone jack
Phone jacks
RCA pin jacks
USB 1.1 44.1/48 kHz, 16 bit
MIC: for microphones
INST (Hi-Z): for guitars, etc.
x2
Adjust the level of CH 1, 2
x1
48 V, only for CH1
x1
Adjusts the overall signal
x1
Red
x1
2 points (green, red)
x1
Green
USB bus-powered
180 x 61 x 112 mm
490 g
Cubase AI DVD-ROM
USB cable
Owner’s Manual

■ Dimensional Diagrams
W: 180

H: 61
52

2

108 D: 112

36
Unit: mm
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+30dBu
+20dBu
+10dBu
0dBu
–10dBu
–20dBu
–30dBu
–40dBu
–50dBu
–60dBu

MIC B
[–60 to –16dBu]
INST
[–44 to 0dBu]

INPUT 1

MIC A
[–60 to –16dBu]
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CH IN MIC Gain: Max [–60dBu]

CH IN INST Gain: Max [–44dBu]

CH IN MIC Gain: Min [–16dBu]

CH IN INST Gain: Min [0dBu]

LINE R
[–34 to +10dBu]

[–6dBu]

Level
(Gain)
[6 to 50dB]
HA

HA

ST CH IN LINE Gain: Max [–34dBu]

Clip Level

[–6dBu]

Level
(Gain)
[10 to 54dB]

HA

ST CH IN LINE Gain: Min [+10dBu]

Clip Level

Hi-Z

PHANTOM (+48V)

MIC/INST

LINE L
[–34 to +10dBu]

INPUT 2

COMBO

SUM

SUM

[–6dBu]

RE
GR

D–
D+
GND
+3.7V

USB

DC-DC

Level (MASTER)
[Nominal: –6dB]

DC-DC

PHONES [0.5mW @ 40ohms]

STEREO OUT [–2dBu]

Clip Level

IN
OUT1
SW_IC EN1
OUT2
EN2

12MHz

USB
REG
[–20dBu]
AUDIO
Vbus (+5V)
LO
SSPND
RO

DC-DC

LPF

LPF

LPF

[–20dBu]
LIN
RIN

+7.5V

RE

GR

[–6dBu]

L R

[–2dBu]

MUTE

BA

BA

DR

LPF

Level
(MASTER)
[–12dBu]

–7.5V

+48V

PHANTOM

+5V

POWER

SUM

SUM

[–6dBu]

DR

PEAK
SIGNAL

STEREO OUT
[–2dBu]

+30dBu
+20dBu
+10dBu
0dBu
–10dBu
–20dBu
–30dBu
–40dBu
–50dBu
–60dBu

PHONES
[0.5mW @ 40ohms]

R

L

Specifications

■ Block Diagram and Level Diagram
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STEREO L
STEREO R

About the accessory disk
SPECIAL NOTICE
• The software included in the accessory disk
and the copyrights thereof are under exclusive
ownership by Steinberg Media Technologies
GmbH.
• Copying of the software or reproduction of this
manual in whole or in part by any means is
expressly forbidden without the written consent
of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible
for the results of the use of this manual and the
software.
• This disk is NOT for audio/visual purpose. Do
not attempt to play the disk on an audio/visual
CD/DVD player. Doing so may result in irreparable damage to your player.
• Note that Yamaha does not offer technical support for the DAW software in the accessory disk.

About the DAW software in the
accessory disk
The accessory disk contains DAW software both
for Windows and Mac.
NOTE • Make sure to install DAW software under
the “Administrator” account.
• In order to have continuous use of the
DAW software in the accessory disk,
including support and other benefits, you
will need to register the software and activate your software license by starting it
while the computer is connected to the
Internet. Click the “Register Now” button
shown when the software is started, then
fill in all required fields for registration. If
you do not register the software, you will
be unable to use it after a limited period
of time expires.
• To install on Mac computers double-click
the “Cubase AI*.mpkg” icon or the
“Cubase AI* Start Center” icon.
“*” indicates where the version number
appears in the actual icon name.
For information about the minimum system
requirements and latest information on the software in the disk, check the web site below.
<http://www.yamahasynth.com/>

About software support
Support for the DAW software in the accessory
disk is provided by Steinberg on its website at the
following address.
http://www.steinberg.net
You can visit the Steinberg site also via the Help
menu of the included DAW software. (The Help
menu also includes the PDF manual and other
information on the software.)
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For details of products, please contact your nearest Yamaha
representative or the authorized distributor listed below.
Pour plus de détails sur les produits, veuillez-vous adresser à Yamaha ou
au distributeur le plus proche de vous ﬁgurant dans la liste suivante.

NORTH AMERICA

CANADA

Die Einzelheiten zu Produkten sind bei Ihrer unten aufgeführten
Niederlassung und bei Yamaha Vertragshändlern in den jeweiligen
Bestimmungsländern erhältlich.
Para detalles sobre productos, contacte su tienda Yamaha más cercana
o el distribuidor autorizado que se lista debajo.

THE NETHERLANDS/
BELGIUM/LUXEMBOURG

Yamaha Music Europe Branch Benelux
Clarissenhof 5-b, 4133 AB Vianen, The Netherlands
Tel: 0347-358 040

Yamaha Canada Music Ltd.
135 Milner Avenue, Scarborough, Ontario,
M1S 3R1, Canada
Tel: 416-298-1311

FRANCE

U.S.A.

Yamaha Corporation of America
6600 Orangethorpe Ave., Buena Park, Calif. 90620,
U.S.A.
Tel: 714-522-9011

CENTRAL & SOUTH AMERICA

MEXICO

BRAZIL

Yamaha Musical do Brasil Ltda.
Rua Joaquim Floriano, 913 - 4' andar, Itaim Bibi,
CEP 04534-013 Sao Paulo, SP. BRAZIL
Tel: 011-3704-1377

ARGENTINA

Yamaha Music Latin America, S.A.
Sucursal de Argentina
Olga Cossettini 1553, Piso 4 Norte
Madero Este-C1107CEK
Buenos Aires, Argentina
Tel: 011-4119-7000

HONG KONG

Yamaha Musica Italia S.P.A.
Combo Division
Viale Italia 88, 20020 Lainate (Milano), Italy
Tel: 02-935-771

INDIA

Yamaha Música Ibérica, S.A.
Ctra. de la Coruna km. 17, 200, 28230
Las Rozas (Madrid), Spain
Tel: 91-639-8888

INDONESIA

ITALY

GREECE

Yamaha Music Latin America, S.A.
Torre Banco General, Piso 7, Urbanización Marbella,
Calle 47 y Aquilino de la Guardia,
Ciudad de Panamá, Panamá
Tel: +507-269-5311

EUROPE

THE UNITED KINGDOM/IRELAND
Yamaha Music U.K. Ltd.
Sherbourne Drive, Tilbrook, Milton Keynes,
MK7 8BL, England
Tel: 01908-366700

GERMANY

Yamaha Music Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

SWITZERLAND/LIECHTENSTEIN

Yamaha Music Europe GmbH
Branch Switzerland in Zürich
Seefeldstrasse 94, 8008 Zürich, Switzerland
Tel: 01-383 3990

AUSTRIA

Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-60203900

CZECH REPUBLIC/SLOVAKIA/
HUNGARY/SLOVENIA

Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-602039025

POLAND/LITHUANIA/LATVIA/ESTONIA
Yamaha Music Europe GmbH
Branch Sp.z o.o. Oddzial w Polsce
ul. 17 Stycznia 56, PL-02-146 Warszawa, Poland
Tel: 022-500-2925

Tom Lee Music Co., Ltd.
11/F., Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: 2737-7688

Yamaha Music India Pvt. Ltd.
5F Ambience Corporate Tower Ambience Mall Complex
Ambience Island, NH-8, Gurgaon-122001, Haryana, India
Tel: 0124-466-5551
PT. Yamaha Musik Indonesia (Distributor)
PT. Nusantik
Gedung Yamaha Music Center, Jalan Jend. Gatot
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: 021-520-2577

Philippos Nakas S.A. The Music House
147 Skiathou Street, 112-55 Athens, Greece
Tel: 01-228 2160

KOREA

Yamaha Scandinavia AB
J. A. Wettergrens Gata 1, Box 30053
S-400 43 Göteborg, Sweden
Tel: 031 89 34 00

MALAYSIA

YS Copenhagen Liaison Ofﬁce
Generatorvej 6A, DK-2730 Herlev, Denmark
Tel: 44 92 49 00

PHILIPPINES

SWEDEN

DENMARK

PANAMA AND OTHER LATIN
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES

Yamaha Music & Electronics (China) Co.,Ltd.
2F, Yunhedasha, 1818 Xinzha-lu, Jingan-qu,
Shanghai, China
Tel: 021-6247-2211

Yamaha Musique France
BP 70-77312 Marne-la-Vallée Cedex 2, France
Tel: 01-64-61-4000

SPAIN/PORTUGAL

Yamaha de México S.A. de C.V.
Calz. Javier Rojo Gómez #1149,
Col. Guadalupe del Moral
C.P. 09300, México, D.F., México
Tel: 55-5804-0600

ASIA

THE PEOPLE’S REPUBLIC OF CHINA

FINLAND

F-Musiikki Oy
Kluuvikatu 6, P.O. Box 260,
SF-00101 Helsinki, Finland
Tel: 09 618511

NORWAY

Norsk ﬁlial av Yamaha Scandinavia AB
Grini Næringspark 1, N-1345 Østerås, Norway
Tel: 67 16 77 70

ICELAND

Skifan HF
Skeifan 17 P.O. Box 8120, IS-128 Reykjavik, Iceland
Tel: 525 5000

RUSSIA

Yamaha Music (Russia)
Room 37, bld. 7, Kievskaya street, Moscow,
121059, Russia
Tel: 495 626 5005

OTHER EUROPEAN COUNTRIES

Yamaha Music Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: +49-4101-3030

AFRICA

Yamaha Corporation,
Asia-Paciﬁc Sales & Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2313

MIDDLE EAST

TURKEY/CYPRUS

Yamaha Music Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

OTHER COUNTRIES

Yamaha Music Gulf FZE
LOB 16-513, P.O.Box 17328, Jubel Ali,
Dubai, United Arab Emirates
Tel: +971-4-881-5868

SY55

HEAD OFFICE

Yamaha Corporation, Digital Musical Instruments Division
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, Japan 430-8650
Tel: +81-53-460-2432

Yamaha Web Site (English only) http://www.yamahasynth.com/
Yamaha Manual Library http://www.yamaha.co.jp/manual/

Yamaha Music Korea Ltd.
8F, 9F, Dongsung Bldg. 158-9 Samsung-Dong,
Kangnam-Gu, Seoul, Korea
Tel: 02-3467-3300
Yamaha Music (Malaysia) Sdn., Bhd.
Lot 8, Jalan Perbandaran, 47301 Kelana Jaya,
Petaling Jaya, Selangor, Malaysia
Tel: 03-78030900
Yupangco Music Corporation
339 Gil J. Puyat Avenue, P.O. Box 885 MCPO,
Makati, Metro Manila, Philippines
Tel: 819-7551

SINGAPORE

Yamaha Music (Asia) Pte., Ltd.
#03-11 A-Z Building
140 Paya Lebor Road, Singapore 409015
Tel: 6747-4374

TAIWAN

Yamaha KHS Music Co., Ltd.
3F, #6, Sec.2, Nan Jing E. Rd. Taipei.
Taiwan 104, R.O.C.
Tel: 02-2511-8688

THAILAND

Siam Music Yamaha Co., Ltd.
4, 6, 15 and 16th ﬂoor, Siam Motors Building,
891/1 Rama 1 Road, Wangmai,
Pathumwan, Bangkok 10330, Thailand
Tel: 02-215-2622

OTHER ASIAN COUNTRIES

Yamaha Corporation,
Asia-Paciﬁc Sales & Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2313

AUSTRALIA

OCEANIA

Yamaha Music Australia Pty. Ltd.
Level 1, 99 Queensbridge Street, Southbank,
Victoria 3006, Australia
Tel: 3-9693-5111

NEW ZEALAND

Music Works LTD
P.O.BOX 6246 Wellesley, Auckland 4680,
New Zealand
Tel: 9-634-0099

COUNTRIES AND TRUST
TERRITORIES IN PACIFIC OCEAN
Yamaha Corporation,
Asia-Paciﬁc Sales & Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2313

C.S.G., Pro Audio Division
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